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Get Started with Temporal Data 
 

In the lessons that follow, you'll learn how to manage, analyze, and map temporal data in 

ArcGIS for Desktop). You'll use techniques such as time-enabled mapping, analysis using models 

with an iterator, and analysis using tools with a case field. 

You'll learn these techniques through a case study about Dreissena polymorpha, commonly 

known as the zebra mussel. Even though this mollusk is usually about the size of a fingernail,1 it 

has earned a well-deserved reputation as a national threat. It's on the list of the world's top 100 

invasive species.2 The United States Geological Survey (USGS) calls it "the most serious 

nonindigenous biofouling species ever in the freshwater systems of North America."3 The zebra 

mussel ultimately led to passage of the National Invasive Species Act in 1996 and has been 

called "the poster species for invasive law."4 Most disturbingly, once zebra mussels have 

become established in a water body, they are impossible to fully eradicate, and no solution has 

been found to kill them without harming other species.5  

Although it seems like there's little that can be done, people can help by reporting zebra mussel 

sightings and taking measures to prevent the mollusks' spread. The first thing people need to 

do is to learn all they can about zebra mussels—what they are, how to identify them, where 

they came from, how they spread, and what threats they pose. Then people can use this 

information themselves and share it with others. Your goal in this project is to find out what 

you can about the geographic aspects of the zebra mussel issue so that you can then share that 

important information with others. 

Build skills in these areas: 

 Creating temporal maps 

 Creating cumulative density maps 

                                            
1 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015) 
2 http://www.issg.org/database/species/search.asp?st=100ss (accessed October 29, 2015) 
3 http://www.fs.fed.us/invasivespecies/speciesprofiles/documents/zebra_mussel.pdf (accessed October 29, 2015) 
4 http://www.necis.net/intro-to-invasive-species/what-we-know/introducing-the-infamous-invaders/zebra-
mussel/ (accessed October 29, 2015) 
5 http://www.nwf.org/Wildlife/Threats-to-Wildlife/Invasive-Species/Invasive-Mussels.aspx (accessed October 29, 
2015) 

http://www.nationalatlas.gov/articles/biology/a_zm.html
http://www.issg.org/database/species/search.asp?st=100ss
http://www.fs.fed.us/invasivespecies/speciesprofiles/documents/zebra_mussel.pdf
http://www.necis.net/intro-to-invasive-species/what-we-know/introducing-the-infamous-invaders/zebra-mussel/
http://www.necis.net/intro-to-invasive-species/what-we-know/introducing-the-infamous-invaders/zebra-mussel/
http://www.nwf.org/Wildlife/Threats-to-Wildlife/Invasive-Species/Invasive-Mussels.aspx
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 Analyzing the geographic distribution of temporal data 

What you need: 

 ArcGIS for Desktop 

 Estimated time: 2 hours, 30 minutes 

 
Title 
 

Description Time 

Lesson 1: Explore the issue and 
ask spatial questions 

Review information about the 
invasion of the zebra mussels. 

10 minutes 

Lesson 2: Map the zebra 
mussel sightings and learn 
more about the distribution 

Explore a map of zebra mussel 
distribution in the United States and 
Canada to learn where the mollusks 
are. 

20 minutes 

Lesson 3: Map the zebra 
mussel sightings over time 

Create a temporal map of zebra 
mussels to learn where they first 
came from. 

20 minutes 

Lesson 4: Map the zebra 
mussel density over time 

Use a model to create a map with 
cumulative density rasters of sightings 
to learn how many zebra mussels 
there are and whether there are more 
zebra mussels in some areas than 
others. 

40 minutes 

Lesson 5: Analyze how zebra 
mussels have spread over time 

Use the Directional Distribution and 
Mean Center statistical analysis tools 
and create a temporal map of the 
results to learn how the zebra 
mussels are spreading. 

30 minutes 

Lesson 6: Review the spatial 
questions and evaluate the 
results 

Review the results of your analyses 
and determine whether you have 
answered the spatial questions 
adequately. 

10 minutes 

Lesson 7: Add a timeline to the 
map (optional) 

Create a timeline as a set of 
geographic features and symbolize it. 

20 minutes 

Lesson 8: Add ellipses to the 
timeline (optional) 

Edit the timeline to show miniature 
versions of the ellipses on the map. 

15 minutes 

 
Related Esri Training resources: 

 Exploring Spatial Patterns in Your Data Using ArcGIS provides an additional explanation of 
analysis using the Mean Center and Directional Distribution tools: 
training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2052 

http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2052
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 Introduction to Surface Modeling Using ArcGIS includes an analysis with the Kernel Density tool: 
training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2053 

http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2053
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Lesson 1: Explore the issue and ask spatial questions 
 

In this lesson: 

 Explore the issue. 

 Ask spatial questions. 

 

Step 1: Explore the issue 

 

Zebra mussels are native to the Black, Caspian, and Azov Seas in southeastern Europe and have 

steadily spread throughout much of Europe. They first appeared in North America in 1988 in 

Lake St. Clair, a small lake connecting Lake Huron and Lake Erie, and they were thought to have 

been transported in the freshwater ballast of a transatlantic ship. There are now estimated to 

be up to 10 trillion zebra mussels in the Great Lakes alone. 6 

 

Photo courtesy of US Geological Survey. 

(http://nas.er.usgs.gov/taxgroup/mollusks/zebramussel/zebra_gallery.aspx) 

Like clams, oysters, and scallops, zebra mussels are small bivalve mollusks. They get their name 

from the striped pattern on their shell. They are usually smaller than a dime but can grow to 

                                            
6 http://www.nwf.org/Wildlife/Threats-to-Wildlife/Invasive-Species/Invasive-Mussels.aspx (accessed October 29, 
2015) 

http://nas.er.usgs.gov/taxgroup/mollusks/zebramussel/zebra_gallery.aspx
http://www.nwf.org/Wildlife/Threats-to-Wildlife/Invasive-Species/Invasive-Mussels.aspx
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two inches long. They live for four to five years, and females can start breeding at two years of 

age, bearing between 30,000 and 1 million eggs a year, about 2 percent of which reach 

adulthood. 

 

Zebra mussels are the only breed of freshwater mollusk that can firmly attach themselves to 

solid objects.7 Zebra mussels will latch onto any hard surface—boats, pilings, water intake 

valves, even other aquatic species and plants—and can easily reattach themselves when 

dislodged. A million of them can cover one square meter. 

Zebra mussels are extremely adaptable and can adjust to a wide range of conditions. They can 

also spread in a variety of ways. Young zebra mussels can swim and are easily carried by 

currents, so waters downstream from an infected area have a high probability of becoming 

infected. Attached to transported boats, adult zebra mussels have hitched rides to places not 

connected by waterways. Very small juveniles (1–3 mm) look like black pepper and can be 

easily overlooked, and they may also attach themselves to transported objects, including 

                                            
7 http://www.lakegeorgeassociation.org/what-we-do/invasive-species/Zebra-Mussels.asp (accessed October 29, 
2015) 

http://www.lakegeorgeassociation.org/what-we-do/invasive-species/Zebra-Mussels.asp
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aquatic plants or crustaceans and even fishing rods. Migrating waterfowl can transport larval or 

young zebra mussels in their feathers or on their feet. Larval mussels can also be transferred in 

water through ballast exchange, bilge pumps, or bait buckets. 

 

Environmental impacts 

Although zebra mussels have a positive impact on some other species, environmental impacts 

are overwhelmingly negative. While many fish, birds, and other animals eat young and adult 

mussels, this is not enough to keep the mussels' populations under control. In addition, 

anything that feeds heavily on zebra mussels will build up high levels of contaminants in its 

body.8 Zebra mussels have driven out entire native species (such as other mussels) from lakes.9 

Zebra mussels have devastated native populations of alewives, salmon, whitefish, and other 

mussels by stripping the food web of phytoplankton. They can colonize other aquatic species, 

such as mussels and clams, to such an extent that the hosts cannot move or feed.10 Zebra 

                                            
8 http://www.in.gov/dnr/files/ZEBRA-MUSSEL.pdf (accessed October 29, 2015) 
9 http://www.noaa.gov/features/earthobs_0508/zebra.html (accessed October 29, 2015) 
10 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015) 

http://www.in.gov/dnr/files/ZEBRA-MUSSEL.pdf
http://www.noaa.gov/features/earthobs_0508/zebra.html
http://www.nationalatlas.gov/articles/biology/a_zm.html
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mussels have also attached themselves to slow-moving species, such as turtles and crayfish.11 

Filter feeding and excretion activity by invasive mussels can stimulate nutrient releases in the 

water column, causing algal blooms.12 These algal blooms have caused botulism outbreaks, 

killing thousands of fish and aquatic birds and, of course, impacting human recreation. 

Migratory birds have even changed their flight patterns in response to zebra mussel availability 

to prey on them.13 

Recreational impacts 

Dead and dying mussels degrade beaches and nearshore swimming areas. Beaches and 

nearshore areas become littered with sharp-edged shells, and the fumes from the decaying 

mussels are foul. Zebra mussels can also cause boating and navigation hazards.14 Boats can be 

impacted by increased drag caused by zebra mussel colonization on the hull. Juvenile zebra 

mussels can get into engine cooling systems, causing overheating and other damage.15 Zebra 

mussels can also impact navigation by damaging the wood, steel, and concrete of piers, docks, 

and other structures. The mussels' added weight has also sunk buoys and other navigational 

markers.16 

Commercial impacts 

Zebra mussels have caused damage and increased operating expenses worth hundreds of 

millions of dollars for facilities with conduits to fouled waters. The colonization of zebra mussels 

can cause equipment to become unusable, valves and other components to become 

obstructed, and intake screens to reduce water flow. Fishery populations have also been 

affected.17 Colonized areas can become corroded or damaged. 

Eradication 

                                            
11 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015) 
12 http://www.sciencedaily.com/releases/2014/02/140212112747.htm (accessed October 29, 2015) 
13 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015) 
14 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015) 
15 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015) 
16 http://www.bioone.org/doi/abs/10.3394/0380-1330-34.4.770 (accessed October 29, 2015) 
17 http://www.necis.net/intro-to-invasive-species/what-we-know/introducing-the-infamous-invaders/zebra-
mussel/ (accessed October 29, 2015) 

http://www.nationalatlas.gov/articles/biology/a_zm.html
http://www.sciencedaily.com/releases/2014/02/140212112747.htm
http://www.nationalatlas.gov/articles/biology/a_zm.html
http://www.nationalatlas.gov/articles/biology/a_zm.html
http://www.nationalatlas.gov/articles/biology/a_zm.html
http://www.bioone.org/doi/abs/10.3394/0380-1330-34.4.770
http://www.necis.net/intro-to-invasive-species/what-we-know/introducing-the-infamous-invaders/zebra-mussel/
http://www.necis.net/intro-to-invasive-species/what-we-know/introducing-the-infamous-invaders/zebra-mussel/
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Once zebra mussels become established in a body of water, they are impossible to eradicate 

with current technology.18 Chemical treatments, mechanical controls, and filters have been 

tried. Chemicals that kill zebra mussels also kill other species. Mechanical scrapers have been 

tested, and equipment has been developed to pre-oxidize water at intake valves. Physical 

barriers and coatings have been used to prevent mussels from attaching to surfaces. 

Approaches involving hot water, air, and even sound have also been investigated. To this point, 

no ideal solution currently exists to remove and control zebra mussels. 

Knowing all this, you can now begin to formulate questions related to the geographic aspects of 

the zebra mussel issue. 

 

Step 2: Ask spatial questions 

 

The spatial questions you'll answer are the following: 

1. Where are the zebra mussels? 

2. Where did the zebra mussels come from? 

3. Are there more zebra mussels in some areas than in others? 

4. Are the zebra mussels spreading? 

Each of these questions has a spatial component. One way to test this is to ask whether the 

questions can only be answered by taking location into account. If the answer is yes, they're 

spatial. 

To answer these questions, you'll use a variety of approaches, including visual analysis of maps 

and statistical analysis of spatiotemporal data. 

In the next lesson, you'll begin by answering the question, where are the zebra mussels? 

                                            
18 http://www.nationalatlas.gov/articles/biology/a_zm.html (accessed October 29, 2015)  

http://www.nationalatlas.gov/articles/biology/a_zm.html
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Lesson 2: Map the zebra mussel sightings and learn more 
about the distribution 
 

In this lesson: 

 Map the zebra mussel sightings. 

 Learn more about the distribution using additional layers. 

In the last lesson, you learned about the zebra mussel problem and identified four spatial 

questions that will help you learn more about the issue. In this lesson, you'll first explore a map 

to learn about the distribution of mussels in the United States and Canada. You'll explore the 

attribute data associated with the data on the map. You'll also use additional map layers to 

better understand the geographic distributions. 

 

Step 1: Map the zebra mussel sightings 

 

For this project, you'll use ArcGIS for Desktop to map and analyze the data. You'll also work 

with a map that has been started for you. 

1. Open ArcMap. 

 

Tip: Learn more about downloading the free trial version of ArcGIS for Desktop  

(http://www.esri.com/arcgis/trial). 
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2. On the main menu, click File > Open. 

 

 

3. Browse to the C:\student\Zebra_Mussels directory. Click Zebra_Mussels.mxd and click 

Open to open the map document. 

 

 
 

On this map, the Mussel Sightings layer shows the locations where zebra mussels have 

been sighted. This layer is displayed over the Esri World Ocean Basemap and its 

Reference layer. 

 

 
 

Note: The Esri World Ocean Basemap is a layer that's being displayed from ArcGIS 

Online. If there were no Internet connection, this layer would not be displayed. 
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4. Right-click the Mussel Sightings layer and click Open Attribute Table. 

 

 

5. Scroll down to see when the sightings were recorded and where. 

 

 
 

Note: The mussel sightings data was collected by the USGS and downloaded from the 

National Atlas website (http://www.nationalatlas.gov/mld/zmusslx.html, accessed 

October 29, 2015). 

http://www.nationalatlas.gov/mld/zmusslx.html
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This data is associated with the point features on the map. Note that there are columns, 

or fields, for many attributes, including the month and year mussels were first recorded 

and the county in which they were reported. 

6. Right-click the NAME column and click Sort Ascending. 

 

 
 

Note that this dataset also contains sightings for another type of mussel—the quagga 

mussel. 

You only want to include the zebra mussels in this study, so you'll use a definition query 

to restrict the set so that it excludes the 463 quagga mussel sightings. 

7. Click the Close button in the upper right corner to close the attribute table. 
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8. Right-click the layer and click Properties. 

 

 

9. Click the Definition Query tab. 
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10. Click the Query Builder button. 

 

 

11. On the Query Builder dialog box, click the NAME field, then click <> (not equal to). Click 

Get Unique Values and click quagga mussel. 

 

The expression should appear as shown below. 

 

 

12. Click Verify to make sure there are no errors in the expression. 

 

 

13. Click OK on the Verifying expression dialog box. 
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14. Click OK to close the Query Builder dialog box. 

15. Click OK to close the Layer Properties dialog box. 

 

 
 

The map will update to show only zebra mussels. For example, the sightings in Arizona 

and Nevada are no longer displayed, since those were for quagga mussels. 

 

Note that there are many overlapping point locations for the sightings. In this dataset, 

the sightings are precisely located, and some are even coincident. In a later lesson, you'll 

learn how to display the density of this data. 

 

Although there's limited information on this map, you can use it to answer the first 

spatial question—where are the zebra mussels? 

 

Interpret: The sightings are concentrated in the Great Lakes area, but zebra mussels 

have also been found throughout the Midwest from Appalachia to Colorado. Sightings 

have also been recorded in the Southwest, though there are fewer of them. 

 

Zebra mussels also appear to follow waterways—you'll confirm this by viewing a new 

layer on the map. 
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Step 2: Map the zebra mussel sightings 

 

For this project, you'll use ArcGIS for Desktop to map and analyze the data. You'll also work 

with a map that has been started for you. 

1. In the table of contents, click the box to the left of the World Hydro Reference Overlay 

layer to turn it on. 

 

Tip: You can turn layer viewing on and off by checking the check box to the left of the 

layer name. A check will appear when viewing is on. 

 

 
 

Note: Like the Esri World Topographic Basemap, the World Hydro Reference Overlay 

layer is from ArcGIS Online. 

2. Use the pan and zoom buttons on the Tools toolbar to explore the map and learn about 

where zebra mussels have been sighted. 
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Interpret: You'll learn that they have been reported in 9 of the 10 longest rivers in the 

conterminous United States—the Missouri, Mississippi, Saint Lawrence, Arkansas, 

Atchafalaya, Ohio, and Red Rivers east of the Continental Divide, and the Colorado River 

in the West. Only the Rio Grande has escaped invasion to this point. 

 

Zebra mussels have also invaded some smaller rivers, such as the Wabash in Indiana and 

the Cumberland in Tennessee, and lakes, like the Finger Lakes in New York, that are 

connected to these larger river systems. 

3. In the table of contents, turn off the Hydro Reference Overlay layer and turn on the 

State and Province Sightings layer. 

 

 
 

Note: The State and Province Sightings data is from Natural Earth 

(http://www.naturalearthdata.com/). 

 

The State and Province Sightings layer shows the US states and Canadian provinces that 

have reported zebra mussel sightings. 

 

Interpret: On this map, you can see that there have been sightings in most US states and 

http://www.naturalearthdata.com/
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in two Canadian provinces. There have not yet been any sightings in the Northwest 

(Washington, Oregon, Idaho, Montana, Wyoming, and South Dakota), nor have zebra 

mussels been sighted in the Southeast (North Carolina, South Carolina, Georgia, and 

Florida). A few other states along the Eastern Seaboard have also escaped invasion 

(Maine, New Hampshire, Rhode Island, New Jersey, and Delaware). 

4. Turn off the State and Province Sightings layer and turn on the United States 

Department of the Interior (USDOI) USGS National Hydrography Dataset (NHD) layer. 

 

 
 

The NHD layer shows the United States classified into 18 major regions based on 

hydrology.19 The regions contain either the drainage area of a major river, such as the 

Missouri River, or the drainage areas of a set of rivers, such as the Texas-Gulf region, 

which is made up of the drainages for a number of rivers that empty into the Gulf of 

Mexico. 

 

Interpret: On this map, you can see that 14 of the 18 major hydrologic regions have 

been invaded by zebra mussels—only the Rio Grande (HUC 2-12), Lower Colorado (HUC 

2-15), Great Basin (HUC 2-16), and Pacific Northwest (HUC 2-17) regions remain 

uninfected. 

                                            
19 http://water.usgs.gov/GIS/huc.html (accessed October 29, 2015) 

http://water.usgs.gov/GIS/huc.html
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5. Turn off the NHD layer. 

6. On the main menu, click File > Save to save the map. 

 

 

Now that you know where the zebra mussels are, you'll learn more about where they first came 
from, which is the topic of the next lesson. 
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Lesson 3: Map the zebra mussel sightings over time 
 

In this lesson: 

 Set the time properties on the layer. 

 Use the Time Slider window to display the layer over time. 

 Display the data cumulatively. 

 Change the symbology of the layer. 

 Create the Zebra Mussel Sightings layer. 

In the last lesson, you looked at a map of all zebra mussel sightings. Looking at maps of the 

sightings year by year will help you learn where they were first sighted. Then you can answer 

the question, where did the zebra mussels come from? 

In this lesson, you'll start by setting the time properties on the Mussel Sightings layer. Then 

you'll use the Time Slider window to display the layer over time. You'll also modify some time 

property options and the symbology to highlight aspects of the display that will allow you to 

better understand the change over time. Finally, you'll create a new feature class that contains 

only the zebra mussel sightings, which you will use in the remaining lessons. 

There are two steps to displaying temporal data with ArcGIS: 

1. Set the time properties on the layer. 

2. Display the layer using the Time Slider window. 

 

Step 1: Set the time properties on the layer 

 

In this step, you'll set the time properties for the layer. To do this, you need to know the format 

of the temporal attributes in your data and how the features that vary over time are 

represented geographically. In the last lesson, you learned that the zebra mussel sightings are 
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represented as point features and that there's an attribute called YEAR to indicate when each 

sighting occurred. You'll use that information to set the time properties on the layer. 

1. Open the layer properties for the Mussel Sightings layer. 

2. Click the Time tab. 

3. Check the Enable time on this layer check box. 

 

 
 

The other settings on the dialog box are now enabled. 

 

 

4. For Layer Time, keep the default set to Each feature has a single time field. 
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5. Set Time Field to YEAR. 

 

 
 

Tip: For Time Field, you can use any attribute that's sortable, either numerically or 

alphabetically. You might use an attribute that's not a time or date if you wanted to 

show the change in a nontemporal attribute, for example, the magnitude of 

earthquakes or depth of wells. 

 

You can see that there's a message reminding you that the selected field is not indexed 

and that you should index the field for better display performance. 

 

 
 

When a layer has many features or features with complex geometry, such as lines or 

polygons with many vertices, the display may slow down significantly. One way to 

improve display performance is to index the time fields. The layers you're working with 

won't have display issues, so you don't need to index the time fields. 

6. Click Calculate to determine the time extent of the layer. 

 

 
 

The first and last time steps will be updated automatically. 

7. Since the data in this layer was collected by year, set Time Step Interval to 1.00 and keep 

the default unit setting of Years. 

 

 
 

Note: For your data, you do not need to use the additional options to calculate the time 

extent automatically, set a time zone, or use a time offset. 

8. Click OK. 
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9. Save the map. 

 

Step 2: Use the Time Slider window to view the layer over time  

 

Once the time properties for the layer are set, you can display the layer using the Time Slider 

window. This window provides controls and additional options that allow you to display 

temporal data in ArcMap, ArcScene, and ArcGlobe. 

1. Open the Time Slider window by clicking the Open Time Slider window button on the 

Tools toolbar. 

 

 

Tip: This button is not enabled if you don't have any time-enabled datasets in your 

ArcMap, ArcScene, or ArcGlobe document. 

2. Click the Play button to display the layer over time. 

 

 

3. Move the Time Slider control to set the display to the first time period. 
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Interpret: This map helps you answer the question, where did the zebra mussels come 

from? You can see that they were first sighted in 1986 in Lake Erie—one sighting was in 

the east end of the lake, and the other was in the west. But wait—recall how you read in 

Lesson 1 that others have reported that zebra mussels were discovered in North 

America in 1988 in Lake St. Clair. Your map suggests that those accounts are wrong and 

that zebra mussels were actually sighted two years earlier in a different lake altogether! 

 

And your map is right! That's because scientists at the USGS updated their data based 

on an authoritative report that described these earlier sightings.20 The report also 

confirmed that zebra mussels are hypothesized to have been introduced to North 

America in the ballast water of a ship that had traveled from Europe to the Great Lakes. 

There's more you can learn from these maps, but the data will be easier to interpret if you 

display it cumulatively so that you can see not just the current time step but also all previous 

time steps. 

                                            
20 http://www.bioone.org/doi/abs/10.3394/0380-1330-34.4.770 (accessed October 29, 2015) 

http://www.bioone.org/doi/abs/10.3394/0380-1330-34.4.770
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Step 3: Display the data cumulatively 

 

In this step, you'll enable the option to display the zebra mussel data. You'll also change the 

symbology of the layer so that you can distinguish maps from among the time steps. 

1. Open the layer properties for the Mussel Sightings layer.  

2. On the Time tab, check the Display data cumulatively check box at the bottom. 

 

 

3. Click OK. 

4. Use the Time Slider window to display the layer over time. 

 

 
 

On this map, it's easier to see how the distribution has changed over time, but it's 
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difficult to distinguish individual time steps. You can fix that by changing the symbology 

of the layer. 

5. Save the map. 

 

Step 4: Change the symbology of the layer 

 
 

You'll use a method called Match to symbols in a style, which will assign prespecified symbols to 

the point features based on an attribute—in this case, the year. The symbology you set for this 

layer will also be used for others later in this project. 

1. To see the style that contains the symbols, click Customize > Style Manager on the main 

menu. 
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2. On the Style Manager dialog box, click Styles. 

 

 

3. On the Style References dialog box, click Add Style to List. 
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4. Browse to the C:\student\Zebra_Mussels directory and select the Zebra_Mussels.sty 

file. 

 

 
 

The style will be displayed in the left pane of Style Manager. 

 

Note: The file extension for an ArcGIS style file is .sty. 

5. Click the box with the plus sign to the left of the Zebra Mussels folder to expand its view. 

 

 
 

Note that there are symbols for some types (Color Ramps, Colors, and so forth), as 

indicated by yellow folders, but not for others, which are shown with white folders. 

6. Click the Marker Symbols folder to see the symbols. 
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Note that the symbols' names are the same as the year values for the zebra mussel 

sightings. 

7. Close the dialog box. 

 

To use the Match to symbols in a style option, there must be a text attribute in the layer 

with values that exactly match the names of the symbols, so you'll need to check if 

there's such a field. 

8. Open the layer properties for the Mussel Sightings layer. 

9. On the Fields tab, click the YEAR field. 
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Note that this is a numeric field type. Recall that this data is from the USGS, so the field 

types are already set in the data. You cannot change a field type, but you can create a 

new field of the type you want and calculate the values to be equal to those in another 

field. 

10. Close the Layer Properties dialog box. 

11. Open the attribute table for the Mussel Sightings layer. 
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Note that not all the records are shown. This is because time is still enabled on the map, 

so the only records you see in the table are those for the current time step. If you 

calculate the values in a field while time is enabled, only the current time step's records 

will be calculated. So, you need to disable time on the map. 

12. In the Time Slider window, click the first button in the upper left corner to disable time 

on the map. 

 

 

13. On the attribute table toolbar, click the Table Options button and click Add Field. 

 

 

14. Type "Year_Text" as the name, change Type to Text, and set Length to 4. 
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15. Click OK. 

16. Scroll to the right to see the added field. 

17. Right-click the Year_Text field name and click Field Calculator. 

 

 

18. In the Fields list, double-click YEAR. 
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It will appear in the expression area. This expression will calculate Year_Text to equal 

YEAR. 

19. Click OK and check that the values have been updated. 

 

 

20. Close the attribute table. 

21. Open the layer properties. 
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22. On the Symbology tab, click Categories > Match to symbols in a style. 

 

 

23. Set Value Field to Year_Text. 

 

 

24. Click the Browse button to browse to and select the Zebra_Mussels style. 

 

 

25. Click Match Symbols. 

 

The symbols will be changed to those in the style. 

26. Click the check box next to <all other values> to turn off the display for these features. 

 

 
 

Note: Although there are zero features with other values, which is indicated by the 

count to the right of the label, unchecking this option will also turn off this symbol 

display in the table of contents. 

27. Click OK. 
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28. Click the box with the minus sign next to the Mussel Sightings layer to collapse its view 

in the table of contents. 

29. Open the Time Slider window and click the first button in the upper left corner to enable 

time on the map. 

 

 
 

 
 

On this map, it's easier to keep track of the change over time. To help you see this even 

better, you'll turn on a timeline that was created for this map. The timeline will show 

the entire time extent and a clear indication of the current time step. It will also serve as 

a legend for the map. 

30. Click the box with the plus sign next to the Timeline group layer to expand its view. 
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There are two layers. The bottom one has gray symbols, and the top one has the same 

symbols as the Mussel Sightings layer. 

31. Collapse the view for the Timeline group layer. 

32. Turn on the Timeline group layer. 
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Although you can use the information in the Time Slider window to track the 

progression of time, the timeline allows you to do this more efficiently because it's part 

of the map display, and the features in the timeline are visually associated through their 

symbology with those on the map. In this way, the timeline also serves as a legend for 

the map. Additionally, the features in the timeline are displayed over time in a north-to-

south order, much like the overall pattern of zebra mussel sightings on the map. 

 

Note: Lesson 7 provides instructions for making this timeline. 

33. Move the Time Slider control to 1990. 
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Interpret: By 1990, only four years after being introduced to North America, zebra 

mussels had been sighted in all the Great Lakes and were moving into the Saint 

Lawrence River. 

34. Click the Next Time Step button to advance one time step to 1991. 
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Interpret: By 1991, zebra mussels had escaped the Great Lakes and found their way 

farther down the Saint Lawrence River and down the Mohawk to the Hudson River in 

New York. They had also reached the Mississippi River via the Illinois River. 

35. Advance to the next time step. 
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Interpret: By 1992, zebra mussels had made their way to the mouth of the Saint 

Lawrence River at Quebec. They had also been sighted in the waters of the Arkansas, 

Cumberland, Ohio, and Tennessee Rivers and were making their way down the 

Mississippi River to the Gulf of Mexico. 

36. Turn on the State and Province Sightings layer. 

37. Advance two years to 1994. 

 

 
 

Interpret: Only eight years after their introduction to North America in the Great Lakes, 

zebra mussels had found their way to the sea via the Saint Lawrence, Hudson, and 

Mississippi Rivers. They were found in the water bodies in or adjacent to 16 US states 

(Alabama, Arkansas, Illinois, Indiana, Iowa, Kentucky, Michigan, Minnesota, Mississippi, 

New York, Ohio, Oklahoma, Pennsylvania, Tennessee, Vermont, and West Virginia) and 

2 Canadian provinces (Ontario and Quebec). 

38. Advance through the other time steps, turning helpful layers on or off to learn more 

about the invasion of the zebra mussels. 

 

Interpret: You'll learn that in 1999, they were found in the Missouri River between Iowa 
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and Nebraska. In 2001, they were reported farther downstream in the Missouri River in 

the state of Kansas. In 2003, they invaded Virginia as well as water bodies in Nebraska. 

In 2008, they were in the upper reaches of the Arkansas River in Colorado. That same 

year, they were sighted on the other side of the Continental Divide, at the headwaters 

of the Colorado River in Utah; they also found their way to California. In 2009, they 

invaded Texas and Massachusetts. In 2010, they moved into North Dakota. By 2011, 

they had been sighted in 30 US states and still only 2 Canadian provinces. 

39. Save the map. 

You've now answered two of your four spatial questions. Before going any further, you'll do a 

little data management by creating a new feature class that contains only the zebra mussel 

sightings, which you'll use in the remaining lessons. 

 

Step 5: Create the Zebra Mussel Sightings layer 

 

There are two reasons to create a new layer containing only the sightings for zebra mussels—

both relate to the definition query that you set on the Mussel Sightings layer so that quagga 

mussel sightings would not be shown: 

 Definition queries tend to slow the drawing time when displaying data over time. 

 Definition queries cannot be used in any layers from which web map services are 

created. 

Since the mussel sightings data is fairly simple (in other words, there are not many features and 

the geometry is not complex), you may not notice an improvement in drawing performance. 

However, you'll be making a map service from this layer in a later exercise, so for that reason 

alone, you'll want to create this new feature class. 

You'll create the feature class by exporting the data for the Mussel Sightings layer. Because this 

layer has a definition query, only features that meet the query criteria will be exported. 
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1. Right-click the Mussel Sightings layer in the table of contents and click Data > Export 

Data. 

 

 

2. On the Export Data dialog box, keep the default options to export all features using the 

coordinate system of the data frame, and set the Output feature class to 

Zebra_Mussel_Sightings in the C:\student\Zebra_Mussels\Zebra_Mussels geodatabase. 
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3. Click OK. 

4. Click No so that the exported data is not added to the map as a layer. 

 

 

You could add the data to ArcMap and redefine the layer properties, but an easier approach is 

to change the source of the Mussel Sightings layer to the Zebra_Mussel_Sightings feature class. 

Doing this will prevent your having to reapply the symbology and reset the time properties. 

5. Open the layer properties for the Mussel Sightings layer. 

6. On the Source tab, click Set Data Source. 

 

 

7. Browse to the C:\student\Zebra_Mussels\Zebra_Mussels geodatabase and click the 

Zebra_Mussel_Sightings feature class. 

8. Click Add. 

 

 
 

The source will be updated. 
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9. On the General tab, change the layer name to Zebra Mussel Sightings. 

 

 

10. On the Definition Query tab, press the Backspace key on your keyboard to erase the 

query. 

11. Click OK.  

 

This layer will look the same, but it can now be used to create a map service. 

In the next lesson, you'll answer the questions, how many zebra mussels are there, and are 

there more zebra mussels in some areas than in others?
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Lesson 4: Map the zebra mussel density over time 
 

In this lesson: 

 Create the mosaic dataset. 

 Add the model to ArcToolbox. 

 Run the model. 

 Calculate statistics for the mosaic dataset. 

 Change the symbology of the layers. 

 Add the time field to the Footprint layer. 

 Display the cumulative density rasters over time. 

As you saw in the last lesson, one of the challenges with mapping the data for the zebra mussel 

sightings is that many of the symbols overlap. Instead of trying to determine the number of 

zebra mussels by mapping the points, you can make a density map to show where the points 

are concentrated. 

Density maps are generated and displayed as a continuous surface in which there's a smooth 

gradation from areas of higher concentrations to areas of lower concentrations. The density 

surface is generated in ArcMap as a raster layer. For each cell in the raster layer, you can find 

the density of the features, such as the number of sightings per square mile. 

One way to calculate density would be to use the sightings for a single year. Another way would 

be to use the sightings for a year and all previous years. You'll use the second option to 

generate cumulative density maps. 

In this lesson, you'll use a model that has been created to generate these density maps. The 

model will produce 26 rasters, one for each year and using the sightings in that year and all 

previous years. To display these rasters over time, you'll add them to a mosaic dataset, because 

you can enable time on a mosaic dataset just as you did for the Mussel Sightings layer in 

Lesson 3. 

The steps you'll follow in this lesson represent standard workflows for including temporal 

analysis in a model using iterators and mosaic datasets to display raster data over time. These 
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workflows require some data management, such as creating the mosaic dataset, calculating 

statistics, adding fields, and calculating field values. Although this means that it takes longer for 

you to actually see the maps, you'll know what steps to take in the future to work with 

temporal models and display raster data over time. 

 

Before you start: Learn about mosaic datasets 

 

A mosaic dataset is created in a geodatabase and then rasters are added to it. When rasters are 

added to a mosaic dataset, a pointer to the location of the data is stored within the mosaic 

dataset. The actual raster data is not transferred to or stored within the mosaic dataset. 

When a mosaic dataset is added to ArcMap, the layer that appears in the table of contents is 

shown as a special group layer that always has the same three layers—Boundary, Footprint, and 

Image—each of which is also displayed on the map. 

 

Each of these layers has its own layer properties: 

 The Boundary layer displays the boundary of the entire mosaic dataset. By default, the 

boundary is the extent of all the raster datasets within the mosaic dataset. 

 The Footprint layer displays the footprints for each raster within the mosaic dataset. The 

attribute table of the Footprint layer displays a list of all the rasters in the mosaic 

dataset and many of their properties, such as the minimum and maximum pixel sizes, 

that are used to display the raster in the mosaicked image. You can add a time field to 

this attribute table to display the rasters in the mosaic dataset over time. 

 The Image layer controls the display of the rasters. For this layer, you can modify the 

display properties, such as the color ramp, stretch, resampling, and mosaic method. 
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In this lesson, you'll learn how to work with these layers to show raster data over time. 

Because you'll be generating a lot of new data, you'll start by creating a new file geodatabase to 

store the rasters. In this geodatabase, you'll create the mosaic dataset that a model will add the 

rasters to. Then you'll add the model to ArcToolbox and use it to generate the cumulative 

density rasters and add them to the mosaic dataset. You'll display the mosaic dataset over time 

to see the changes in the density of zebra mussel sightings. 

 

Step 1: Create the mosaic dataset 

 

You'll create the new file geodatabase in the Catalog window. 

1. On the Standard toolbar, click the Catalog button to open the Catalog window. 
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2. Right-click the Zebra_Mussels folder name and click New > File Geodatabase. 

 

 

3. Rename the geodatabase Zebra_Mussel_Density using the same method as renaming a 

layer. 

 

Now you'll create the mosaic dataset in this new geodatabase. One thing you need to 

specify when creating a mosaic dataset is the coordinate system. You'll use the same 

coordinate system as the feature classes in the Zebra_Mussels geodatabase, so you 

need to find out what that is. 

4. Right-click any feature class in the geodatabase and click Properties. 

5. Click the XY Coordinate System tab. 
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Note that the Current coordinate system is 

WGS_1984_Web_Mercator_Auxiliary_Sphere. 

6. Close the Feature Class Properties dialog box. 

7. Right-click the Zebra_Mussel_Density geodatabase and click New > Mosaic Dataset. 

 

 

8. Make sure the Output Location is the Zebra_Mussel_Density geodatabase and name the 

mosaic dataset Cumulative_Density. 



Lesson 4: Map the zebra mussel density over time 

Copyright © 2017 Esri. All rights reserved. Page 4-6 

 

 

9. Click the browse button for the Coordinate System parameter and select the WGS 1984 

Web Mercator (auxiliary sphere) projection, which is in the Projected Coordinate 

Systems > World folder. 
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10. Click OK on the Spatial Reference Properties dialog box. 

11. Click OK on the Create Mosaic Dataset dialog box to finish creating the mosaic dataset. 

12. Click the Close button in the upper right corner of the results dialog box to close it. 
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The mosaic dataset will appear in the Catalog window. 

 

 
 

The mosaic dataset group layer will appear in the table of contents, but it will not 

display on the map because no rasters have yet been added to it. 

 

 
 

For the rasters to be added to the mosaic dataset when you run the model in the next 

step, the mosaic dataset cannot be in the ArcMap document, so you need to remove it. 

13. Right-click the Cumulative_Density group layer in the table of contents and click 

Remove. 
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14. Save the map. 

Now you can use the model to generate the rasters and add them to the mosaic dataset. 

 

Step 2: Add the model to ArcToolbox  

 

In this step, you'll add the model to ArcToolbox. 

1. On the Standard toolbar, click the ArcToolbox button to open the ArcToolbox window. 
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2. Right-click ArcToolbox and click Add Toolbox. 

 

 

3. Browse to the C:\student\Zebra_Mussels directory, click the Zebra Mussels toolbox, and 

then click Open to select it. 

 

 
 

The Zebra Mussels toolbox will appear at the bottom of the ArcToolbox window. 
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Tip: Toolboxes appear alphabetically when they are added. 

4. Expand the view for the Zebra Mussels toolbox to see the Cumulative Density model. 

 

 

5. Save the map. 

 

Step 3: Run the model 

 

In this step, you'll run the model and calculate statistics for the mosaic dataset. Before running 

the model, you'll enable the ArcGIS Spatial Analyst extension because the model uses the 

Kernel Density tool, which is in the Spatial Analyst toolbox. 
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1. On the main menu, click Customize > Extensions. 

 

 

2. On the Extensions dialog box, check the Spatial Analyst check box and click Close. 

 

 

3. In ArcToolbox, right-click the Cumulative Density model and click Edit to view it. 
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This model selects the points for each year and all previous years and uses them to 

create a cumulative density raster. The raster is then added to the mosaic dataset. 

 

Note that the model has a For iterator. Iterators are used in models to repeat a process 

on a set of inputs. In this model, it repeats the process for each year. 

  

 

4. Double-click the For iterator to see its parameters. 

 

 
 

The From Value parameter is set to 1986, the first year in the data. The To Value 

parameter is set to 2011, the last year. The By Value parameter is set to 1 so that the 

process is repeated for each year. The value that's being used in the tools is stored in 
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the Value variable, shown in the bright green oval. 

 

 

5. Close the dialog box. 

6. Double-click the Value variable. 

 

 
 

This variable will update as the model runs. This value is used in the three tools in this 

model. 

7. Close the dialog box. 

8. Double-click the Select Layer By Attribute tool. 
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Note that the expression uses the Value variable, indicated by %Value%. When the YEAR 

attribute is less than or equal to the year in the Value variable, the points in the current 

year and all previous years will be selected. They are then used as the input for the 

Kernel Density tool. 

 

Note: If you wanted to create density rasters using the sightings for each single year, 

you would change the expression to YEAR = %Value%. 

9. Close the dialog box. 

10. Double-click the Kernel Density tool. 
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Note that the output raster name will include the year. Also, note that the output 

density value will be in square kilometers, so values for the cells will be the number of 

sightings per square kilometer. 

11. Close the dialog box. 

12. Double-click the Add Rasters To Mosaic Dataset tool. 
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The cumulative density raster for each year will be shown in the Input Data parameter. 

13. Close the dialog box. 

14. Click the Validate Entire Model button to make sure there are no errors in the model. 

 

 

15. Click the Run button to run the model. 

 

 
 

The progress will be noted on the results dialog box. 
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16. Close the results dialog box. 

 

 

17. When the model has finished running, click the X in the upper right corner to close it. 

18. Click Yes when asked if you want to save the changes. 

 

19. Open the Catalog window. 
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The cumulative density rasters have been created and added to the mosaic dataset. 

Next, you'll calculate statistics for the mosaic dataset so that you can properly display it. 

20. Save the map. 

 

Step 4: Calculate statistics for the mosaic dataset 

 

Statistics are required for your raster and mosaic datasets in order to perform certain tasks, 

such as applying a contrast stretch or classifying your data. Calculating statistics on the 

mosaic dataset will allow you to apply a contrast stretch using the Stretched renderer with a 

color ramp that has been created for you. 

1. Right-click the Cumulative_Density mosaic dataset and click Enhance > Calculate 

Statistics. 
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2. Keep the default parameters and click OK to run the tool. 
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This process will take a minute or so. 

3. Close the results dialog box. 

4. Click the Cumulative_Density mosaic dataset and drag it into the ArcMap map display. 
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Note that all the points in the Zebra Mussel Sightings layer are currently selected 

because the last time step included 2011 and all previous years. You'll clear the features 

so that you can see them better. 

5. On the Standard toolbar, click Selection > Clear Selected Features. 

 

 
 

The zebra mussel sightings will now be displayed with their symbology over the 

cumulative density rasters. 
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6. Save the map. 

The next step is to change the symbology of the layers in the Cumulative_Density group layer. 

 

Step 5: Change the symbology of the layers 

 

In this step, you'll modify the symbology used to display the mosaic dataset. 

1. Turn off viewing for the Boundary layer, since you do not need to show the extent of the 

mosaic dataset. 

2. Turn off viewing for the Footprint layer, since you do not need to show the extent of 

each cumulative density raster. 
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3. Open the layer properties for the Image layer and click the Symbology tab. 

 

 

4. Right-click the drop-down arrow next to the color ramp to turn off Graphic View. 

 

 
 

When Graphic View is unchecked, the name of the color ramp appears instead. 

 

 

5. Click the drop-down arrow and scroll to the bottom to select the Zebra Mussel Density 

color ramp. 

 

 



Lesson 4: Map the zebra mussel density over time 

Copyright © 2017 Esri. All rights reserved. Page 4-25 

 

Note: This color ramp is in the Zebra Mussels style that you referenced in Lesson 2. 

6. Check the Invert check box. 

 

 
 

The colors will now range from yellow for high values to white for low values. 

 

 
 

A few more modifications to the symbology will improve the appearance of the layer. 

7. Check the Display Background Value check box. 

 

 
 

By keeping the default number (0) and symbology (No Color), cells with a value of 0 will 

not be displayed, so cells with no density will not be shown on the map. 

8. Change the Stretch Type to Percent Clip and set the max to 1. 

 

 
 

This will provide more color variation in the midrange of cell values. 

9. Check the Apply Gamma Stretch check box and set the value to 2.5. 
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This will increase the contrast in the lighter colors. 

10. On the Display tab, set Transparency to 50 percent. 

 

 

11. Click OK. 

12. Turn off all but the Cumulative_Density, Reference, and Basemap layers. 
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On this map, which shows the density raster for the last time step, you see the 

cumulative density for all zebra mussel sightings. Areas of higher density are displayed 

in reds, and areas of lower density are displayed in purples. The lowest values, in white, 

fade into the background so that you do not focus on them. This map helps you see how 

dense the zebra mussel sightings are and where there are areas with similar densities. 

 

Interpret: As you can probably guess by now, some of the highest density areas are 

around the Great Lakes, where zebra mussels first invaded North America's freshwater 

systems. There are a couple of surprises, though, such as the very high densities in 

Minneapolis and midstate Missouri, and other high-density areas in Duluth, at the 

southern tip of Illinois, and at the mouth of the Mississippi River. The density of 

sightings in these areas was not apparent on the point symbol maps. 

 

Now you'll take a look at the area of highest concentration. 

13. On the main menu, click Bookmarks > Lake Champlain. 
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The map will zoom to a predefined bookmark around Lake Champlain between upstate 

New York and Vermont. 

 

 
 

You can find the density values using the Identify tool. 

14. On the Tools toolbar, click the Identify button. 

 

 

15. Click a cell in the center of the lake. 
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Note that the values in multiple cumulative density rasters are shown. You can click any 

year to see the value for that year. 

 

In the example above, the cell had a value of .0306 sightings per square kilometer in the 

topmost layer, which is the cumulative density raster for 2010. This value does not 

represent an actual count because the density surface graduates smoothly from the 

highest-concentration areas to the lowest. So, the best way to interpret a density raster 

is to look at the relative differences rather than the absolute values. 

16. Click other cells to see how their values decrease as the distance from the center of the 

lake increases. 

17. On the Tools toolbar, click the Go Back To Previous Extent button to return the view to 

the previous extent. 
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In the next step, you'll prepare the data so that you can display the rasters over time. 

18. Save the map. 

 

Step 6: Add the time field to the Footprint layer 

 

In this step, you'll add a field to the attribute table of the Footprint layer. This field will be used 

as the time field, and it will allow you to display the cumulative density rasters over time. 

1. Open the attribute table for the Footprint layer. 

 

 
 

Note that the Name field contains information about the year. You'll use this to 

calculate the values in a new time field. 
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2. Add a field by naming it Year with the Type default of Short Integer. 

 

 

3. Scroll to the right to right-click the Year field and click Field Calculator. 

 

 

4. Enter the expression shown below and click OK. 
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This expression calculates the values for the time field to be the last four characters in 

the Name field. 

 

Tip: You can change the Type to String and select the Right function to build the 

expression interactively. 

5. Click OK. 

 

 
The Year values will be updated, starting with 1986 for the first record. 
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6. Close the attribute table. 

7. Save the map. 

The last step is to display the rasters over time. 

 

Step 7: Display the cumulative density rasters over time 

 

In this step, you'll set the time properties on the Cumulative_Density group layer and then use 

the Time Slider window to display the rasters over time. 

1. Open the layer properties for the Cumulative_Density group layer. 

2. Click the Time tab. 

 

 
 

Note that the tabs on the Layer Properties dialog box are different from the layers 
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you've been working with so far. That's because this layer is a mosaic dataset. However, 

there's still a Time tab. 

3. Set the time properties as shown below and click OK. 

 

 

4. Move the Time Slider control to 1990. 
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Interpret: By 1990, there was a high concentration of zebra mussel sightings in the west 

end of Lake Erie, but even more zebra mussels were sighted in the east end of the lake 

and the west end of Lake Ontario. There were also concentrated sightings in lower Lake 

Michigan. 

5. Advance the Time Slider control to 1991. 
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Note that the extent of the density rasters is no larger than the maximum extent of all 

the input point features, so for some years, like 1991, the edge effects will be apparent. 

 

Interpret: A year later, the concentration of sightings in Lake Michigan was moving 

north. There was also a concentration of sightings in Lake Superior near Duluth and in 

the Hudson River of New York. 

6. Advance to the next time step. 
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Interpret: By 1992, the concentration of zebra mussel sightings in Lake Ontario spread 

down the Saint Lawrence River to its mouth. On this map, you're starting to see 

evidence of their spread along waterways in the linear pattern of some of the 

concentrations. Note the connected concentrations from Lake Erie to Lake Ontario to 

the mouth of the Saint Lawrence River in Montreal. Also, note the linear concentration 

along the Mississippi River in southeast Minnesota. 

7. Advance to 1995. 
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Interpret: By 1995, zebra mussel sightings were also concentrated further downstream 

in the Mississippi River at the southern tip of Illinois and in the river's delta at the Gulf of 

Mexico. Lower concentrations are also evident in other rivers, including the Hudson, 

Ohio, Tennessee, Arkansas, and Illinois, giving the impression that these river systems 

provided opportunities for zebra mussels to spread downstream. 

8. Advance through the other time steps, zooming in or out to learn more about the 

density of zebra mussel sightings. 

 

Interpret: You'll learn that by 1996, the highest concentrations were found in Lake 

Champlain, a pattern that was repeated in all remaining time periods. In 2007, a 

separate concentration was found in the Lake of the Ozarks in Missouri. Recall that 

zebra mussels can be transported to new waters on recreational boats, fishing gear, and 

other objects. Perhaps this is how zebra mussels first got into the waterways of the 

Ozarks. 

9. Save the map. 

In this lesson, you answered the question, are there more zebra mussels in some areas than in 
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others? You also saw patterns suggesting that they spread within lakes and along rivers. In the 

next lesson, you'll use spatial statistics to confirm your suspicion that the zebra mussels are 

spreading. 
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Lesson 5: Analyze how zebra mussels have spread over time 
 

In this lesson: 

 Analyze the directional trends. 

 Change the symbology of the ellipses. 

 Analyze the central tendency. 

 Change the symbology of the points. 

 Display the ellipses and points over time. 

 Create a ghosted copy of the ellipses. 

You learned in the last lesson that you can get a sense of the spread in the distribution of zebra 
mussel sightings when you visually analyze maps of the change over time; however, spatial 
statistics tools give you statistical evidence to confirm your impressions. With these tools, you 
can summarize the spatial pattern of the zebra mussel sightings in terms of directional trends 
and central tendency. 

To determine whether there's a directional trend in the distribution for each year, you'll use the 
Directional Deviation tool to create features called standard deviation ellipses. The ellipses 
allow you to see whether the distribution of features is elongated and has a particular 
orientation. Comparing the size, shape, overlap of ellipses, or changes in ellipses from year to 
year may indicate how the zebra mussels are spreading. 

To analyze the central tendency, you'll use the Mean Center tool to create point features 

representing the center of concentration. This is useful for tracking changes in the distribution 

from year to year. If the mean center shifts, this is an indication of the spread in a certain 

direction and over a certain distance. 

In this lesson, you'll analyze the directional trends and central tendency of the zebra mussel 

sightings for each year, using the spatial statistics tools described above. You'll change the 

symbology of the ellipses and points that are the output of the tools. Then you'll map the 

analysis results over time to confirm whether the zebra mussels are spreading. 
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Step 1: Analyze the directional trends 

 

In this step, you'll use the Directional Distribution tool to create the standard deviational 

ellipses. 

In the last lesson, you used an iterator in a model to analyze the data for each time period. The 

tools you'll use in this lesson have a parameter, called the case field, that will group sightings 

for each year so that an ellipse is created for each time period. For the tool to work properly 

using the case field, you first need to disable time on the layer. 

1. Turn off the Cumulative_Density group layer and collapse its view. 

2. Open the Time Slider window and click the first button in the upper left corner to disable 

time on the map. 

 

 
 

Tip: You could also disable time on the Zebra Mussel Sightings layer. 

3. Close the Time Slider window. 

4. Open the ArcToolbox window and expand the Spatial Statistics Tools toolbox. 

5. In the Measuring Geographic Distributions toolset, double-click the Directional Distribution 

tool. 
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6. On the Directional Distribution dialog box, set the Input Feature Class to Zebra Mussel 

Sightings. 

 

 

7. Set the Output Ellipse Feature Class to Standard_Deviational_Ellipses in the 

C:\student\Zebra_Mussels\Zebra_Mussels geodatabase. 

 

 

8. Keep the default Ellipse Size setting of 1_STANDARD_DEVIATION. 

 

 
 

Note: When the underlying spatial pattern of features is concentrated in the center with 

fewer features toward the periphery (a spatial normal distribution), setting the ellipse size 

to 1_STANDARD_DEVIATION results in an ellipse that contains approximately 68 percent of 

the features. Two standard deviations will contain approximately 95 percent of the 

features, and three standard deviations will contain approximately 99 percent of the 

features. 
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You'll use one standard deviation to create ellipses around the most centralized sightings to 

see how the core areas of concentration have spread over time. 

9. Set the Case Field to Year_Text. 

 

 
 

Note that the case field can be of an integer, date, or string type. You created the 

Year_Text field so that you could use the option Match to symbols in a style, as presented 

in Lesson 3. Using the Year_Text field in this tool will create a separate ellipse for each year. 

 

Tip: The case field you specify will be added to the attribute table of the output ellipse 

feature class.  

10. Click OK to run the tool. 

 

 
 

See the results dialog box and note that the years 1986 and 1987 have too few features to 

create an ellipse; however, ellipses were created for the other years. 

11. Close the results dialog box. 

 

The ellipses have been added to the table of contents and the map display. 
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12. Turn off all but the Standard_Deviational_Ellipses and the Basemap layers. 

 

 
 

This map is largely uninformative because the ellipses for the latest time periods obscure 

those for earlier time periods. You'll change the symbology to improve the display. 

13. Save the map. 

 

Step 2: Change the symbology of the ellipses 

 

You'll symbolize the ellipses using an outline that's the same color as the points for the Zebra 

Mussel Sightings layer. You'll do this by using the option Match symbols in a style. But first, you 

need to create a field that contains the same names as the symbols. 

1. To see the symbols you'll be using, open Style Manager and view the Fill Symbols in the 

Zebra Mussels style. 
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The names of these symbols are the same as the year. Because you used Year_Text as 

the case field when you created the Standard_Deviational_Ellipses layer, that field will 

be added to the attribute table of the ellipses. You'll use that field to match to the 

symbols in the style. 

2. Close Style Manager. 

3. Open the layer properties for the Standard_Deviational_Ellipses layer. 

4. On the Symbology tab, match the symbols by setting the Value Field to Year_Text. 
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Note: The instructions for matching to symbols in a style were presented in Lesson 3. 

5. Check the check box next to <all other values> to turn off the display for these features. 
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6. Click OK to see the map. 

 

 

On this map, you can distinguish the ellipses for each of the years, though they will be 

easier to compare when you display them over time. You'll do that in step 5 of this 

lesson. The most important things to note about the ellipses are their shape, size, and 

center. 

 

The shape indicates whether there's a directional trend. The more elongated the oval, 

the stronger the trend. The ovals on this map indicate that there's a directional trend, 

primarily toward the northeast and southwest. 

 

The size of the ellipse indicates the extent of the distribution and encompasses the 

percentage of features specified by the Ellipse Size parameter in the Direction 

Distribution tool. On this map, the ellipses encompass 68 percent of the sightings for 

each year. Ellipses for the earlier time periods are smaller; for later time periods, larger 

ellipses were generated. 

 

The center of the ellipse is the geographic center (or the center of concentration) for the 

set of features specified—68 percent of the sightings for each year on this map. You can 
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infer this from the shape of the ellipse, but to see the sightings more clearly on the map, 

you can also create these points. In the next step, you'll create the mean center points 

so that they can be displayed along with the ellipses when you examine the change over 

time. 

7. Save the map. 

 

Step 3: Analyze the central tendency 

 

For this step, you'll use the Mean Center tool, which will analyze the central tendency in the 

zebra mussel sightings for each year. The result will be point features that represent the 

geographic center of concentration. The point features will also coincide with the center of the 

ellipses. 

1. In the Measuring Geographic Distributions toolset, open the Mean Center tool. 

2. Set the Input Feature Class to Zebra Mussel Sightings. 

3. Set the Output Feature Class to Mean_Center_Points in the 

C:\student\Zebra_Mussels\Zebra_Mussels geodatabase. 

4. Set the Case Field to Year_Text. 

5. Click OK. 

6. Close the results dialog box. 
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The mean center points will be added to the map. 

On this map, you can see that most of the points are located in or near the Great Lakes, 

indicating that throughout time, the center of concentration has continued to be near 

the location where the mussels were first introduced. 

Because it's difficult to tell which points are associated with which years, you'll 

symbolize the points so that they are the same as the Zebra Mussel Sightings layer. 

7. Save the map. 

 

Step 4: Change the symbology of the points 

 



Lesson 5: Analyze how zebra mussels have spread over time 

Copyright © 2017 Esri. All rights reserved. Page 5-11 

You'll display the mean center points using symbology that is similar to the Zebra Mussel 

Sightings layer, but the mean center points will be larger and distinguishable by a dot in the 

center of the symbol. 

1. Open the layer properties for the Mean_Center_Points layer. 

2. On the Symbology tab, click Categories > Unique values. 

 

 

3. Set the Value Field to Year_Text. 

 

 

4. Click Add All Values. 
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You'll change the default symbology to a circle symbol with a dot in the center. Then 

you'll change the colors of the symbols to match the ellipses. 

5. Right-click next to <all other values> and click Properties for All Symbols. 

 

 

6. Scroll down and select the Circle 3 symbol in the ESRI style. 

 



Lesson 5: Analyze how zebra mussels have spread over time 

Copyright © 2017 Esri. All rights reserved. Page 5-13 

 
 

Note that the symbol size is 18 points so that the symbols will be visually prominent. 

7. Click OK. 

8. Click the heading for 1986 so that it is highlighted. 

 

 

9. Scroll to the bottom and, while holding down the Shift key, click the heading for 2011. 
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All the symbols will now be selected. You'll change their color using a color ramp in the 

Zebra Mussels style that matches the colors used for the ellipses. 

10. Right-click the drop-down arrow next to the color ramp to toggle off Graphic View. 

11. Click the down arrow and scroll to the bottom to select the Zebra Mussel Rainbow color 

ramp. 

 

 
 

 
 

The colors for the point symbols will be updated with the colors in the color ramp. 

12. Check the check box next to <all other values> to turn off the display for these features. 

13. Click OK. 

14. Click OK on the Layer Properties dialog box. 

 



Lesson 5: Analyze how zebra mussels have spread over time 

Copyright © 2017 Esri. All rights reserved. Page 5-15 

 
 

The mean center points can now be associated with the standard deviational ellipses by 

their color. 

15. Save the map. 

 

Step 5: Display the ellipses and points over time 

 

In this step, you'll set the time properties on the Mean_Center_Points, Zebra Mussel Sightings, 

and Standard_Deviational_Ellipses layers. Then you'll use the Time Slider window to display the 

layers over time. 
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1. Set the Time properties for the Mean_Center_Points layer as shown below: 

 

 

2. Do the same for the Standard_Deviational_Ellipses layer. 

3. Turn on the Zebra Mussel Sightings layer. 

4. Open the layer properties for the Zebra Mussel Sightings layer. 

5. On the Time tab, uncheck the Display data cumulatively check box. 

 

 

6. Click OK. 

7. Open the Time Slider window and click the first button in the upper left corner to enable 

time on the map. 
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8. Use the Time Slider window to explore how the features change over time. 

 

 
 

On these maps, you can easily distinguish the mean center points from the zebra mussel 

sightings by their color. You can also see that the ellipses encompass the majority of the 

sightings. However, it is difficult to compare year to year because you have to rely on 

memory to recall the previous displays. 

 

You can remedy that by displaying the ellipses for the previous time periods. To ensure 

that the focus remains on the current time period, you can use a "ghosted," or grayed-

out, display of the ellipses for previous time periods. 
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Step 6: Create a ghosted copy of the ellipses 

 

In this step, you'll copy the Standard_Deviational_Ellipses layer and change its symbology. Then 

you'll set the time properties on the layer so that the data is displayed cumulatively. 

1. Right-click the Standard_Deviational_Ellipses layer and click Copy. 

 

 

2. Right-click the data frame name (Layers) and click Paste Layer(s). 

 

 

3. Move the copied layer under the original layer. 

4. Change the copied layer name to Ghosted Ellipses. 

5. Open the layer properties, and on the Symbology tab, in the Show pane, click Features 

and choose Single symbol. 

 

 



Lesson 5: Analyze how zebra mussels have spread over time 

Copyright © 2017 Esri. All rights reserved. Page 5-19 

6. Click the symbol. 

 

 

7. On the Symbol Selector dialog box, click Fill Color. 

 

 

8. Click No Color. 

 

 

9. Change the Outline Width to 2.25 points. 
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10. Click Outline Color. 

 

 

11. Click Gray 70%. 

 

 

12. Click OK. 

13. On the Display tab, set the Transparent value to 70 percent. 

 

 

14. Click OK. 
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Interpret: Displaying the data over time, you can see that, except for 1989, when there 

were sightings in the lower Great Lakes and in western Lake Superior, all ellipses trend 

southwest to northeast. This indicates that the zebra mussels moved from the Great 

Lakes to the northeast (primarily down the Saint Lawrence River) and the southwest 

(down the Ohio, Illinois, and other rivers) into the Mississippi and other rivers and lakes. 

 

For the early time periods, the size of the ellipses is smaller. For later time periods, 

larger ellipses were generated. This is an indication that the spatial extent of zebra 

mussels is growing over time (i.e., their range is increasing). 

15. Move the Time Slider control to 1988, the first year for which an ellipse was generated. 
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Interpret: In 1988, the zebra mussels were concentrated in western Lake Erie, having 

spread from the southwest where they were originally sighted in 1986. The northeast to 

southwest trend of spreading that is evident in this year will be repeated in most other 

years as well. 

16. Look at the map for 1989. 
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Interpret: In 1989, the zebra mussels had spread east through Lake Erie and into Lake 

Huron. They were also sighted in western Lake Ontario near Duluth. This is the only year 

in which the directional trend of spreading was northwest to southeast. 

17. Look at the maps for 1990 and 1991. 
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Interpret: In these years, the zebra mussels spread throughout the Great Lakes and 

moved into a number of river systems. Also, the spread was primarily in the easterly and 

westerly directions. 

18. Look at the maps for 1992 to 1999. 
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Interpret: From 1992 to 1999, the directional trend was northeast to southwest, and the 

extent of sightings grew. For these years, the ellipses are long and narrow, indicating 

that the spread was primarily toward the northeast (into New England and Lake 

Champlain) and the southwest (down many major waterways, even as far as the mouth 

of the Mississippi River. 

19. Look at the maps for 2000 to 2002. 
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Interpret: From 2000 to 2002, the concentration was primarily in the Great Lakes area. 

The roundness of the ellipses indicates that there was not a strong directional trend in 

these years. 

20. Look at the maps for 2003 and 2004. 
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Interpret: The pattern of spreading in these years is similar to the pattern for 1992 to 

1999, with a directional trend going from northeast to southwest. 

21. Look at the map for 2005. 
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Interpret: The ellipse for 2005 is similar to those for 2000 to 2002, indicating the lack of 

a strong directional trend; however, the ellipse for 2005 is larger, indicating that the 

extent of the zebra mussel has grown. 

22. Look at the maps for the remaining years. 
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Interpret: From 2006 to 2011, the ellipses continued to be oriented northeast to 

southwest, although they were much larger for these years. This is an indication that the 

extent of the zebra mussels continued to grow. The mean center shifted west, as far as 

western Indiana in 2008 and 2010, indicating that spread of zebra mussels in these years 

was primarily to the southwest rather than the northeast. 

23. Save the map. 

You've now answered the last question, are the zebra mussels spreading? Having addressed all 

the questions you set out to answer, you'll evaluate the results of the analyses you performed 

and the maps you made. This is the topic of the next lesson.
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Lesson 6: Review the spatial questions and evaluate the 
results 
 

In this lesson: 

 Review the spatial questions. 

 Evaluate the results. 

In the previous lessons, you performed a number of analyses—some visual, others statistical—

to address the spatial questions you set out to answer. This brings you to the next step—

examining and interpreting the results. You'll evaluate whether the results provide a 

satisfactory explanation or answer to the spatial questions you asked. 

 

Step 1: Review the spatial questions 

 

Start by reviewing the questions you set out to answer: 

1. Where are the zebra mussels? 

2. Where did the zebra mussels come from? 

3. Are there more zebra mussels in some areas than in others? 

4. Are the zebra mussels spreading? 

Did you find the answers? 

 

Step 2: Evaluate the results 
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Think back to the various maps you made and analyses you performed to determine whether 

your findings make sense and your questions have been answered. Your findings are noted in 

the Interpret sections of each lesson and summarized here. 

Question 1: Where are the zebra mussels? 

The sightings are concentrated in the Great Lakes area, but zebra mussels have also been 

found throughout the Midwest from Appalachia to Colorado. Sightings have also been 

recorded in the Southwest, though there are fewer of them. 

Zebra mussels have been reported in 9 of the 10 longest rivers in the conterminous United 

States—the Missouri, Mississippi, Saint Lawrence, Arkansas, Atchafalaya, Ohio, and Red 

Rivers east of the Continental Divide and the Colorado River in the West. Only the Rio 

Grande has escaped invasion to this point. 

They have also invaded some smaller rivers, such as the Wabash in Indiana and the 

Cumberland in Tennessee, and lakes, like the Finger Lakes in New York, that are connected 

to these larger river systems. 

There have been sightings in most US states and in two Canadian provinces. There have not 

yet been any sightings in the Northwest (Washington, Oregon, Idaho, Montana, Wyoming, 

and South Dakota), nor have zebra mussels been sighted in the Southeast (North Carolina, 

South Carolina, Georgia, and Florida). A few other states along the Eastern Seaboard have 

also escaped invasion (Maine, New Hampshire, Rhode Island, New Jersey, and Delaware). 

Of the 18 major hydrologic regions in the conterminous United States, 14 have been 

invaded by zebra mussels—only the Rio Grande (HUC 2-12), Lower Colorado (HUC 2-15), 

Great Basin (HUC 2-16), and Pacific Northwest (HUC 2-17) regions remain uninfected. 

Question 2: Where did the zebra mussels come from? 

Zebra mussels are hypothesized to have been introduced to North America in the ballast 

water of a ship that had traveled from Europe to the Great Lakes. 

Although others have reported that zebra mussels were discovered in North America in 

1988 in Lake St. Clair, those accounts are wrong. Zebra mussels were actually sighted two 
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years earlier in a different lake altogether! They were first sighted in 1986 in Lake Erie—one 

sighting was in the east end of the lake, and the other was in the west. 

By 1990, only four years after being introduced to North America, zebra mussels had been 

sighted in all the Great Lakes and were moving into the Saint Lawrence River. 

By 1991, zebra mussels escaped the Great Lakes and found their way farther down the Saint 

Lawrence River and down the Mohawk to the Hudson River in New York. They also reached 

the Mississippi River via the Illinois River. 

By 1992, zebra mussels had made their way to the mouth of the Saint Lawrence at Quebec. 

They had also been sighted in the waters of the Arkansas, Cumberland, Ohio, and 

Tennessee Rivers and were making their way down the Mississippi to the Gulf of Mexico. 

Only eight years after their introduction to North America in the Great Lakes, zebra mussels 

had found their way to the sea via the Saint Lawrence, Hudson, and Mississippi Rivers. They 

were found in the water bodies in or adjacent to 16 US states (Alabama, Arkansas, Illinois, 

Indiana, Iowa, Kentucky, Michigan, Minnesota, Mississippi, New York, Ohio, Oklahoma, 

Pennsylvania, Tennessee, Vermont, and West Virginia) and 2 Canadian provinces (Ontario 

and Quebec). 

In 1999, they were found in the Missouri River between Iowa and Nebraska. In 2001, they 

were reported further downstream in the Missouri River in the state of Kansas. In 2003, 

they invaded Virginia as well as other water bodies of Nebraska. In 2008, they were in the 

upper reaches of the Arkansas River in Colorado. This same year, they were also sighted on 

the other side of the Continental Divide, at the headwaters of the Colorado River in Utah; 

they had also found their way to California. In 2009, they invaded Texas and Massachusetts. 

In 2010, they moved into North Dakota. By 2011, they had been sighted in 30 US states and 

still only 2 Canadian provinces. 

Question 3: Are there more zebra mussels in some areas than in others? 

Some of the highest-density areas are around the Great Lakes, where zebra mussels first 

invaded North America's freshwater systems. There are a couple of surprises though, such 

as the very high densities in Minneapolis and midstate Missouri, other high-density areas in 

Duluth, at the southern tip of Illinois, and at the mouth of the Mississippi River. The density 

of sightings in these areas was not apparent on the point symbol maps. 
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By 1990, there was a high concentration of zebra mussel sightings in the west end of Lake 

Erie, but even more zebra mussels were sighted in the east end of the lake and the west 

end of Lake Ontario. There were also concentrated sightings in lower Lake Michigan. 

A year later, the concentration of sightings in Lake Michigan was moving north. There was 

also a concentration of sightings in Lake Superior near Duluth and in the Hudson River of 

New York. 

By 1992, the concentration of zebra mussel sightings in Lake Ontario spread down the Saint 

Lawrence River to its mouth. At this time, evidence of their spread can be seen along 

waterways in the linear pattern of some of the concentrations. Note the connected 

concentrations from Lake Erie to Lake Ontario to the mouth of the Saint Lawrence River in 

Montreal. Also, note the linear concentration along the Mississippi River in southeast 

Minnesota. 

By 1995, zebra mussel sightings were also concentrated further downstream in the 

Mississippi River at the southern tip of Illinois and in the river's delta at the Gulf of Mexico. 

Lower concentrations are also evident in other rivers including the Hudson, Ohio, 

Tennessee, Arkansas, and Illinois Rivers, giving the impression that these river systems 

provided opportunities for zebra mussels to spread downstream. 

By 1996, the highest concentrations were found in Lake Champlain, a pattern that was 

repeated in all remaining time periods. In 2007, a separate concentration was found in the 

Lake of the Ozarks in Missouri. Recall that zebra mussels can be transported to new waters 

on recreational boats, fishing gear, and other objects. Perhaps this is how zebra mussels 

first got into the waterways of the Ozarks. 

Question 4: Are the zebra mussels spreading? 

Except for 1989, when zebra mussels were in western Lake Superior, all standard 

deviational ellipses trended southwest to northeast. This indicates that the zebra mussels 

moved from the Great Lakes to the northeast (primarily down the Saint Lawrence River) as 

well as the southwest (down the Ohio, Illinois, and other rivers) into the Mississippi and 

other rivers and lakes. 
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For the early time periods, the size of the ellipses is smaller. For later time periods, larger 

ellipses were generated. This is an indication that the spatial extent of zebra mussels is 

growing over time (i.e., their range is increasing). 

The centers of concentration also changed over time, further indicating spread. From 1986 

to 1995, the mean centers were located in or near Lake Erie, indicating that the highest 

concentration of sightings remained in the lower Great Lakes. From 1996 to 1999, the mean 

center shifted east to locations around Lake Ontario. In these years, zebra mussels moved 

down the Saint Lawrence River toward its mouth at Quebec. They also moved into Lake 

Champlain, where large numbers of sightings were reported. From 2000 to 2004, the mean 

centers were in Michigan, indicating that zebra mussels were concentrated throughout the 

Great Lakes. From 2005 to 2011, the mean centers shifted west, even as far as western 

Indiana in 2008 and 2010, indicating that the highest concentrations of zebra mussels were 

spreading west. 

Now you have satisfactory answers to your questions, so you can share your findings with 

others. 
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Lesson 7: Add a timeline to the map (optional) 
 

In this lesson: 

 Create the features for the timeline. 

 Symbolize the timeline. 

 Label the timeline. 

 Create a ghosted copy of the timeline. 

 Display the timeline over time. 

Although you can use the information in the Time Slider window to track the progression of the 

distributions through time, a timeline allows you to do this more efficiently because it's part of 

the map display, and the features in the timeline are visually associated with those on the map. 

Using the same symbology for the timeline as you did for the zebra mussel sightings allows the 

timeline to also serve as a legend for the map. Additionally, the display of the features in the 

timeline can be similar to the features on the map, thereby creating a visual relationship 

between the two types of features. For example, on the map, zebra mussels were introduced in 

the north and then they moved south; on the timeline, the first year is at the top and the last is 

at the bottom. 

In ArcMap, the only way to show temporal change is to enable time on a layer of geographic 

features, so you'll need to create the timeline as a set of geographic features. Then you'll 

enable time on the layer with those features and use the Time Slider window to visualize both 

the timeline and map over time. 

In this lesson, you'll create the timeline as a set of point features generated with the Create 

Fishnet tool. You'll change the symbology of the points so that they look like the features in the 

Zebra Mussel Sightings layer. You'll label the timeline points with the year. Then you'll display 

the points over a ghosted copy of the timeline. The ghosted timeline will not change over time, 

so it will provide information about the entire time extent to set the context for the time-

enabled timeline. 
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Step 1: Create the features for the timeline 

 

First, you'll gather some information about the measurement units on the map and the 

coordinates of the desired location of the timeline. You'll use that information in the Create 

Fishnet tool. 

1. Right-click the data frame name and click Properties. 

2. On the General tab, note that Display units are meters. 

 

 

3. Click Cancel to close the Data Frame Properties dialog box. 
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4. Move the pointer over a location in the Atlantic Ocean off the coast of Massachusetts. 

 

 

5. Note from the display at the bottom right of the ArcMap window that the coordinates 

are around -7500000, 5200000. 

 

 

6. Move the pointer directly south to a location off the coast of Miami. 
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Note that this location has coordinates of about -750000, 300000. 

7. Open the ArcToolbox window. 

8. Expand the Data Management Tools toolbox and, in the Feature Class toolset, double-

click the Create Fishnet tool. 

 

 
 

The Create Fishnet tool will open. 
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9. Set the Output Feature Class to Timeline in the 

C:\student\Zebra_Mussels\Zebra_Mussels geodatabase. 

 

 

10. Type the coordinates shown below to set the template extent. 
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Tip: Type the Left coordinate first, as that will activate the other coordinate text boxes. 

 

Note: These coordinates will be used to generate timeline polygons at a height-to-width 

ratio of 2:3, which is commonly used for legend boxes. 

11. Set the number of rows to 26 (one for each year) and the number of columns to 1 (so 

that there's one feature per year). 

 

 

12. Check the Create Label Points check box so that a point feature will be created at the 

centroid of each fishnet cell. 

 

 

13. Change the Geometry Type from POLYLINE to POLYGON so that polygon features will be 

created instead of line features. 

 

 

14. Click OK. 

15. Click Close on the Create Fishnet results dialog box. 
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The Timeline label points and polygons will be added to the map and the table of 

contents. 

 

 
 

If you try to add these features to a map in the future, you'll get a warning that the data 

sources are missing spatial reference information. 

 

 
 

You'll use the Define Projection tool to update the coordinate system information 

stored with the datasets. 
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16. Open the ArcToolbox window. In the Data Management toolbox, expand the Projections 

and Transformations toolset and double-click the Define Projection tool. 

 

 

17. Set the Input Dataset or Feature Class to Timeline_label. 

 

 

18. Click the browse button for the Coordinate System parameter and select the WGS 1984 

Web Mercator (auxiliary sphere) projection, which is in the Projected Coordinate 

Systems > World folder. 
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19. Click OK on the Spatial Reference Properties dialog box. 

20. Click OK to run the tool. 

21. Close the results dialog box. 

22. Repeat steps 1 through 21 to define the projection of the Timeline polygon feature 

class.  

23. Save the map. 

In the next step, you'll symbolize the timeline features. 
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Step 2: Symbolize the timeline 

 

In this step, you'll change the symbology of the timeline points so that they are the same as the 

Zebra Mussel Sightings layer. When the timeline and the layer are displayed at the same time, 

there will be an intuitive visual association between the two. 

 

You don't need to use the Timeline polygon layer, so you'll start by removing that from the 

table of contents. 

1. Right-click the Timeline layer and click Remove. 

 

 

2. Rename the Timeline_label layer Timeline. 

3. Open the attribute table for the Timeline layer and add a Year_Text field, as you did for 

the Mussel Sightings layer in Lesson 3. 

4. Calculate the Year_Text values to equal the ObjectID ([OID] - 2012) * -1, as shown 

below. 

 



Lesson 7: Add a timeline to the map (optional) 

Copyright © 2017 Esri. All rights reserved. Page 7-11 

 
 

Tip: The ObjectIDs of the features in the array generated with the Create Fishnet tool 

are numbered starting with the feature at the bottom left. So the feature with an 

ObjectID [OID] of 1 is at the bottom. You want to display the features in the timeline in a 

north-to-south order, much like the overall pattern of zebra mussel sightings over time 

on the map. Using the expression above ensures that the first time step is shown at the 

top. 
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5. Click OK and check that the values range from 2011 to 1986. 

 

 

6. Close the attribute table. 

7. Change the symbology of the Timeline layer using the option Match to symbols in a 

style, as you did in Lesson 3, so that the points are symbolized in the same way as the 

Mussel Sightings layer. 

8. Turn off the display for <all other values>. 

9. Close the Layer Properties dialog box. 
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The points are now symbolized correctly. 

10. Save the map. 

Now that the timeline is displayed correctly, the next step is to label it. 

 

Step 3: Label the timeline 

 

In this step, you'll label the timeline points so that it's possible to track which year is being 

shown in the display. 

Before labeling the points, you'll change the Standard Label Engine to the Maplex Label Engine 

so that you have more control over the label placement. 
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1. Click Customize > Toolbars and check the Labeling toolbar to add it to ArcMap. 

 

 

2. On the Labeling toolbar, click the Labeling drop-down arrow and choose Use Maplex 

Label Engine.  

 

 

3. Click the Label Manager button to open the Label Manager. 
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4. Check the box to the left of the Timeline layer and expand this layer's view. Click the 

Default label class to select it. 

 

 
 

Note that the Label Field is automatically set to Year_Text. 

5. Change the Text Symbol to Calibri 10 points Bold. 

 

 

6. Set Offset to 5 Points. 
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7. Click the Position button. 

 

 

8. On the Position Options dialog box, select East and click OK. 
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9. Click OK to see the labels. 

 

 

10. Save the map. 

The next step is to create a ghosted copy of the timeline. 

 

Step 4: Create a ghosted copy of the timeline 

 

In this step, you'll copy the Timeline layer and change its symbology and labels. Then you'll 

disable time properties on the layer so that it is shown at all times. 

1. Right-click the Timeline layer and click Copy. 
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2. Right-click the data frame name (Layers) and click Paste Layer(s). 

 

 

3. Move the copied layer under the original layer. 

4. Change the copied layer name to Ghosted Timeline. 

5. Open the layer properties and, on the Symbology tab, in the Show pane, click Features 

and choose Single symbol.  
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6. Click the symbol and scroll down to select Ghosted Symbol in the Zebra Mussels style. 

 

 

7. Click OK. 

8. On the Labels tab, change the color of the Text Symbol to Gray 20%. 

 

 

9. Click OK. 
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10. Save the map. 

Now you're ready to display the timeline over time. 

 

Step 5: Display the timeline over time 

 

1. Set the Time properties for the Timeline layer as shown below. 

 

 

2. For the Ghosted Timeline layer, on the Time tab of the Layer Properties dialog box, 

uncheck Enable time on this layer and click OK. 

 

 

3. Use the Time Slider window to display the timeline over time. 
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On this map, it's much easier to track the progression through time. Because the point 

symbols in the timeline are the same as the zebra mussel sighting symbols on the map, 

the timeline also acts as a legend. 

4. Save the map. 

This method for creating a timeline can be modified to create horizontal timelines, timelines 

constructed of rectangular polygons instead of points, and more. The first step is to determine 

where you want the timeline to be placed. Then create the fishnet features. Finally, symbolize 

and label the features. The choices you make about which features to use and how to 

symbolize and label them can result in a wide variety of timelines.
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Lesson 8: Add ellipses to the timeline (optional) 
 

In this lesson: 

 Convert the ellipse features to graphics. 

 Resize and reposition the ellipse graphics. 

 Label the ellipse graphics. 

 Convert the ellipse graphics to features. 

 Display the timeline over time. 

For the map showing standard deviational ellipses over time, it will help map readers to see a 

small replica of the ellipses in the timeline. The timeline ellipses will offer a condensed view of 

the mapped ellipses, allowing better year-to-year comparison. Because the ellipses in the 

timeline are the same color and shape as those on the map, the timeline also acts as a legend. 

In ArcMap, the only way to show temporal change is to enable time on a layer of geographic 

features, so you need to visualize the timeline ellipses as a set of geographic features. These 

will be small replicas of the ellipses on the map, repositioned at their appropriate locations 

along the timeline. 

In this lesson, you'll convert the ellipses on the map to graphics. You'll resize and reposition the 

graphics and you’ll label them in the timeline. Then you'll convert the graphics back to features. 

After adding a time field to the attribute table of the timeline ellipse features, you'll change the 

symbology and enable time on the layer. Then you'll visualize both the timeline and the map 

over time. 

 

Step 1: Convert the ellipse features to graphics 

 

In ArcMap, you can convert a layer's features to graphics (and vice versa). You'll do this so that 

you have the ellipse graphics you need for the timeline. 
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1. Make sure that time is not enabled on the map. 

 

Tip: If time is enabled, only those features that are displayed for the current time step 

will be processed. 

2. Right-click the Standard Deviational Ellipses in the table of contents and choose Convert 

Features to Graphics. 

 

 

3. Click All to convert all the features in the layer to graphics and select the option to Draw 

the converted graphics and draw the features. 
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Tip: If you keep the default option to only draw the converted graphics, you will no 

longer see the features on the map. 

In the next step, you'll modify the size and position of the timeline ellipses. 

 

Step 2: Resize and reposition the ellipse graphics 

 

1. In the table of contents, turn off the visibility for the Standard Deviational Ellipses layer. 
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The ellipses will still be drawn on the map, but these are the graphic ellipses, not the 

geographic features. 

2. To see where to position the ellipses, turn on the Timeline layer. 

3. Move your pointer over the timeline point for the 2011 time step in the Timeline. Note 

that in the lower right corner of the ArcMap window, the coordinates are about 

-7520000 and 3040000 meters. 

4. On the Drawing toolbar, click the Select Elements button. 
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5. Hold down the Shift key while drawing a box around all the ellipses to select them. 

 

 

6. In the ArcMap window, right-click and choose Properties. 
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7. On the Size and Position tab of the Common Properties for Selected Elements dialog 

box, set the X position to -7,520,000 and the Y position to 3,040,000, set Anchor Point to 

the center position, check the As Percentage and Preserve Aspect Ratio check boxes, 

and set the Width and Height parameters for Size to 10%. 

 

 

8. Click OK to keep your changes. 
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All the ellipses will be reduced in size and drawn at the position of the 2011 point in the 

timeline. 

9. Click anywhere except on the ellipses to cancel the selection. 

10. To spread out the ellipses so that you can select them more easily when you reposition 

them, select the ellipse on the top (the small, dark orange ellipse) and move it to the 

location of the point for the 1988 time step. 

 

Note: Recall that no ellipses were generated for the first two time steps because there 

were too few features to generate ellipses for these years. 

11. Hold down the Ctrl key while drawing a box around the remaining ellipses to select all of 

them, including the 1988 ellipse. 

12. Right-click and choose Distribute, then choose Distribute Vertically. 
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The ellipses will be spread out so that you can see them all, but they will not be in the 

correct order. 
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13. Reorder the ellipses, using the color and position of the Timeline points as a guide and 

centering each ellipse over its associated Timeline point, allowing the larger ellipses to 

overlap. 
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Tip: Zooming in to the Timeline area may help you more easily see where to position the 

ellipses. 

14. Hold down the Shift key while drawing a box around all the ellipses to select them. 

15. Right-click and choose Align, then choose Align Center. 
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The ellipses will be lined up over the Timeline points. 

 

 

The next step is to add the labels to the timeline. 
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Step 3: Label the ellipse graphics 

 

In this step, you'll copy the Timeline layer and use the copy to label the ellipses. 

1. In the table of contents, right-click the Timeline layer and choose Copy. 

2. Right-click the data frame name (Layers) and choose Paste Layers(s). 

3. Rename the Timeline layer SDE Timeline Labels. 

4. Turn off the Timeline layer. 

5. Right-click the SDE Timeline Labels layer and choose Properties. 
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6. On the Symbology tab, in the Show pane, click Features and choose Single symbol. 

 

 

7. Click the symbol. 
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8. Set the symbol to Circle 1, change the color to No Color, and change the Size to 7. 
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9. On the Labels tab, click the Placement Properties button. 
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10. In the Placement Properties window, click the Label Offset button. 
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11. Set the Preferred Offset to 25 Points. 

 

 

12. Click OK three times to keep your changes. 

 

Step 4: Convert the ellipse graphics to features 

 

In this step, you'll convert the ellipses back to geographic features so that you can ultimately 

enable time on the layer. 

1. Hold down the Shift key while drawing a box around all the ellipses to select them. 

2. In the table of contents, right-click the data frame name and choose Convert Graphics to 

Features. 

3.  On the Convert Graphics To Features dialog box, name the Output shapefile or feature 

class SDE_Timeline_Features and save it in the Zebra_Mussels geodatabase. 
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4. Check the check box to Automatically delete graphics after conversion. 

 

 
 

Tip: Choosing the option to automatically delete graphics after conversion will remove 

the graphics from the map. 

5. Click OK to convert the graphics to features. 

6. Choose to add the exported data to the map as a layer. 
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The layer will lose its symbology, so you'll have to add an attribute and reset the 

symbology using the option Match to symbols in a style, as you did for a number of 

other layers. 

13. Open the attribute table for the SDE_Timeline layer and add a Year_Text text field with 

a length of 4, as you did for the Mussel Sightings layer in Lesson 3. 

14. Calculate the values to equal [OID] + 1987. 

 

Note: The first timeline ellipse is for the year 1988, so adding 1987 to the ObjectID of all 

the features will give them the correct value for the Year_Text attribute. 

15. Click OK and check that the values range from 1988 to 2011. 

16. Close the attribute table. 

17. Change the symbology of the SDE_Timeline layer using the option Match to symbols in a 

style, as you did in Lesson 3, so that the ellipses are symbolized in the same way as the 

standard deviational ellipses layer. 
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18. Turn off the display for <all other values>. 

19. Close the Layer Properties dialog box. 

 

The ellipses are now symbolized correctly. 

20. Save the map. 

Now that the timeline is displayed and labeled correctly, you're ready to display the ellipses in 

the timeline over time. 

 

Step 5: Display the timeline over time 

 

1. Set the Time properties for the SDE_Timeline_Features layer as shown below. 
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2. Use the Time Slider window to display the timeline along with the standard deviational 

ellipses, mean centers, and associated points over time. 

 

 
 

On this map, it's much easier to track the progression through time. Because the ellipses 

in the timeline are the same colors and shapes as those on the map, the timeline also 

acts as a legend. 

3. Save the map. 


